G&L Modbus TCP Example Revision A 6/3/2019

Note!! This example was done with the Digital MMC Smartdrive and Drive Resident Control 16 Axis. The

programmer is responsible for any settings and wiring that are different due to differences in hardware.

Also note that the Modbus TCP ASFB library is not free-ware and must be purchased from your local

Kollmorgen supplier.

First | created a folder called Modbus TCP Example under the C:\G&L Motion Control Data directory.

€ > v

G&L Motion Control Data
Applications V16.1.1
Applications V18.0.1
Applications16_1
CIP Over Ethernet ASFB V2.2
Ethernet IP Test
Meodbus Serial Example
Modbus TCP Example
ModbusSerial
Open Modbus TCP ASFE V1.0
PiCPro V16.1 Menitor Edition
PiCPro V16.1 Professional Edition
PiCPro V18.0 Maonitor Edition
PiCPro V18.0 Professional Edition

» ThisPC » SYSTEM & DATA (C:) » G&L Motion Control Data

-~

MName

Applications V16.1.1
Applications V18.0.1
Applications16_1

CIP Over Ethernet ASFB V2.2
Ethernet IP Test

Modbus Serial Example

Medbus TCP Example
ModbusSerial

Open Modbus TCP ASFE V1.0
PiCPro V16.1 Monitor Edition
PiCPro V16.1 Professional Edition
PiCPro V18.0 Monitor Edition
PiCPro V180 Professional Edition

: Applications16_1.zip

Date modified Type

221 AM  File folder

15 AM File folder

0AM  File folder

3 AM  File folder
23PM File folder

File folder

File folder

File folder

File folder

File folder

File folder

File folder

File folder
Compressed (zipp... ,
>

After acquiring and unzipping the Open Modbus TCP support files go to the unzipped folder and click on

setup.exe to start the installation process.

v » ThisPC » Desktop » Gandl Stuff » Open ModbusTCPV1 » Open ModbusTCP V1.0

7 Quick access

I This PC

ndub)1_NDO.zip

£ AKD BASIC Servo Drive Firmware (AKD-T-1CAN-01-17-00-000).zip

ascii_sre00

: ascii_srb00.zip
[ Desktop

-~

Mame

=

Manuals

4| autorun.inf
|4] ModbusASFE.ico

ﬁ setup.exe

Date modified

Type 5i

File folder
Setup Information
lcon

Application



ASFB 1.0 Setup program. This program will ingtall
Giddingz & Lewiz Open Modbuz TCP ASFB V1.0
an pour camputer.

% welcome o Giddings & Lewis Open Modbug TCP
=

It iz strongly recommended that you exit all Windows programs
before running thiz Setup Pragram.

Click Cancel to quit Setup and cloze any programs you have
unning. Click Mext to continue with the Setup program .

‘WARNIMG: Thiz program iz protected by copyright law and
international treaties.

Unautharized reproduction or distribution of this program, or any
partioh af it, may result in severe civil ahd criminal penalties.
and will be progecuted to the mawimun extent possible under
law.

Mewt » | Cancel

% Disclaimer

DISCLAIMER: Al programs in thiz release [application demos,
application specific function blocks [45FBs), et are provided
"A5 15, WHERE 15", WITHOUT ANY WARRAMNTIES,
EXPRESS OR IMPLIED. There may be technical or editonal
omiggions in the programs and their specifications. These
programs are provided zolely for user application development
and user assumes all responsibility for their use. Programs and
their content are subject to change without notice.

IV | have read the disclaimer and accept the stated conditions

™ | do not accept the stated conditions.

< Back | Next = | Cancel

Giddings & Lewis Open Modbus/TCP ASFB A

CONTENTS OF THE OPEN MODBUSITCP ASFB CD
Thiz release contains the Giddings & Lewis Open
Modbus/TCP ASFBs and Lib, Examples, and the Manual.
The manual can ke found in the felder Manuals on your
CD. i is a PDF file and can be opened, read, and printed
uging Adobe Acrobat Reader. Note: YWou MUST use
Acrobat Reader 4.0 or newer to view these manuals.
Acrobat Reader can be downleaded free of charge
from Adobe at

hitp:ihwew w adobe. comisupportservice/custsupport/do
wnload.html. The manual on the CD is not available in a
hard copy format. it can be printed using the Acrobat
Reader. You can also use the PiCPro for Windows
Help | Function/Function Block Help.

ASFRS b

< Back | Mest » | Cancel




Because this installation predates Windows 10 the default destination folder is under the x386 directory.
This will cause issues so in this example we’re going to install it to the C:\G&L Motion Control Data

directory

Click on Browse...

Setup will ingtall Giddings & Lewis Open Modbus TCP ASFE
%1.0in the following folder.

To install into a different folder, click Browse, and select
another folder.

Y'ou can chooze not ko install Giddingz & Lewiz Open Modbuz
TCP ASFBE 1.0 by clicking Cancel ha exit Setup.

Destination Folder

L. AOpen Madbus TCP ASFE V1.0

< Back Mewt » | Cancel |




% Choose Destination Location ot

Select Destination Directory W B
I; [#26]%Giddings & LewishOpen Modbus TCP ASFE V1.0 o
(= oo
[=r Program Files [«86) Cancel -
#e Giddings & Lewis
£ D5APm
= o svstem & data j
¢ Back | MHest > | Cancel |
% Choose Destination Location pod
Select Destination Directory v B
IE:'\G&L tation Control DatahOpen Modbus TCP ASFB K
Aation Control Data Cancel
bz

£ Applications W16.1.1

£ Applications W18.0.1

£ Applications16_1

(£ CIF Ower Etheret ASFB V2.2
£ Ethemet 1P Test

£ Modbusz Serial Example

£ Modbus TCP Example




After installation is complete there should be a folder in that directory called Open Modbus TCP ASFB
V1.0. If you navigate to it you can see the contents. There are 2 folders: ASFB and Examples.

« « A [ » ThisPC > SYSTEM&DATA(C) » GAL Motion Control Data > Open Modbus TCP ASFE V1.0 v & | SearchOp.. o
Dell " Name Date modified Type si
Doctools ASFB AM  File folder
G&L Motion Cantrol Data Examples File folder
Applications V16.1.1 El msTaLLLOG Text Document
Applications V18.0.1 £ readme.htm HTML Document

8 UNWISE.EXE

Applications16_1 AM  Application

CIP Over Ethernet ASFB V2.2
Ethernet IP Test Select a file to preview.
Modbus Serial Example

Modbus TCP Example

ModbusSerial

Open Modbus TCP ASFB V1.0

PiCPre V16.1 Menitor Edition

There are sample files per the Modbus TCP ASFB manual that are for two cases where the G&L
controller is the client in one case or the server in the other.

The manual is included in the zip support file for Modbus TCP

Marme - ~  Date modified Type Size
Manuals 2/14/2019 &:16 AM File folder
4| autorun.inf 12/1/2002 1210 PM Setup Information 1KE
|¢] ModbusASFB.ico 6/3/1997 1:04PM  Icon 1KB
Open MODBUS TCP ASFE.zip 10/21/201411:54 ... Compressed (zipp... 433 KB
ﬂ* setup.exe 12/9/2002 1:16 PM Application 256 KB

Per the manual there are 2 sample ladder ( LDO ) example ladder but in this application note the G&L
controller will be the Server ( also known as Modbus TCP Slave ).

G&L Server ASFBs
E_MODSEX.LDO Example MODBUS/TCP ladder with
the G&L as the Server.
E MODSVR.LDO MODBUS/TCP Server source ladder.
G&L Client ASFBs

E MODCEX.LDO Example MODBUS/TCP ladder with
the G&L as the Client.

E MODCL.LDO MODBUS/TCP Client source ladder.



| copied the E_MODSEX.LDO and E_MODSEX.REM from the Open Modbus TCP ASFB V1.0 folder.

< v » This PC » SYSTEM B DATA (C:) » GEBIL Motion Control Data » Open Modbus TCP ASFE V1.0 » Examples
GE&L Motion Control Data G Mame Date modified Type
Applications V16.1.1 [4] E_MODCEX.Ido 02 10:40 AM  PiCPro Ladder File
Applications V18.0.1 ] E_MODCEX.rem /9/2002 10:40 AM  REM File
Applications16_1 |':| E_MODSEX.Ido /9/2002 10:27 AM  PiCPro Ladder File
CIP Over Ethernet ASFB V2.2 | E_MODSEX.rem 12/9/2002 10:27 AM  REM File

Ethernet [P Test

Medbus Serial Example
Modbus TCP Example
ModbusSerial

Open Modbus TCP ASFB V1.0
PiCPre V16,1 Monitor Edition

And then pasted it into the folder | created for this example project called Modbus TCP Example. The
intent is to be able to edit the example ladder and leave the original alone for potential reference and
use in the future as a template.

v 4 » ThisPC » SYSTEM & DATA (C:) » GE&L Motion Control Data »

1uB01_MDOzip 2 Mame Date modified Type Size

J BASIC Serve Drive Firmware (AKD-T-ICAN-01-17-00-000).zip Applications V16,11 019 11:21 AM  File folder

1i_sr600 Applications V18.0.1 File folder
ii_srb00.zip Applications16_1 File folder
ktop CIP Over Ethemet ASFB V2.2 File folder
Erorer Ethernet [P Test File folder
Modbus Serial Example File folder
wnloads
Modbus TCP Example File folder
! Visualization Builder IDE EM (REV 2.22,353).
e e ( )2ip ModbusSerial File folder
6155 Open Modbus TCP ASFB V1.0 File folder

IN16153.zip PiCPre V16,1 Menitor Edition

File folder




Next | created a project also saved to the Modbus TCP Example folder.
Once the project is created the following paths were setup.
The MAIN.LDO is the copied E_MODSEX.LDO ( it could have been renamed if desired ).

The PicPro Library paths point to the standard libraries for this version of PicPro, the ASFB folder that
was created and populated when the Open Modbus ASFB V1.0 was installed, and the standard ASFB
library for this verion of PicPro ( part of the Applications disk install ).

= g PROJECT NAME: [CAGEL Motion Control Data\Modbus TCP Example\KVB Modbus TCP Example.PRJ]

== @ MAIN LDO
~-[Be] €A\G&L Motion Control Data\Modbus TCP Example\E_MODSEX.Ido

@ COMPRESSED FILE

= @ ricpro version

L.UER PiCPro V12.0 Professional Edition

=~ @ PiCPro LIBRARY PATHS

-PATH CAG&L Motion Control Data\PiCPro V18.0 Professional Edition\ LIBRARIES
w-PATH C:AG&L Motion Control Data\Open Modbus TCP ASFB V1.00ASFB

E.....-FFITH CAGEL Motion Control Data\Applications V18.0.1VASFB

UDFBs/TASKs

SERVO SETUP FILES

SERCOS SETUP FILES
PROFILE SETUP FILES
DRIVE FILES

OTHER FILES




Under the View pull-down menu->Hardware Declarations | configured this for the hardware of my demo.
This will depend on your hardware.

Hardware Declarations ? >

File Edit Toocls Help

= Hardware I/0 Expansion Option
=1 Master Rack
L (" Master Rack Onl
Slat 1 Empty aster Rack Only

~
{« Block 140

Slot 2 MMC Digital Resident 16 Axiz Servo 1.3 Application
-- El ||:| [ I-:Z_ | .-" |:|

I/0 Config/Scan Options
" Mone

Recanfigurable Block, [0
= and continue ba goan with
ki azter Back, Remote

Rack aor Block 140 failures

Pool tMemary Option
|

SPACEBAR for keyboard access to board selection popup menus.
SHIFT + F10 far kevboard access to edit command popup menus.




Per the above my Ethernet port is on Slot 2 ( which is the Digital MMC Drive Resident card ). For other
hardware types the Slot number of the Ethernet port may vary. You will need to edit the Slot# on the
following function block input for the correct slot # of your device.

B Network #4
If you rewvise this example do the following:
B Network #5
Example ASFB for the Modbus/TCP Server.
- SERVER
| E_MODSVR |
ENABLE SCON_OK
| 7 - ENOO CNOK { 3 |
SCON_FL
2 > 1{sSLOT  CNFL |- { —
BOOLS[0] — BOOL CERR (—3 SC_ERR
RCMDA
255 »—{ BSIZ RCV1 { —
DATA[0]  —{ DATA ERR1 — CON1_ERR
MSG_FL1
255 +— DSIZ TER1 { —
EXPT[0] »—| EXPT COD1 — MSG_ERR1
RCMD2
R —R RCV2 |- { —
ERR2 |— CON2_ERR
MSG_FL2
TERZ - { —
COD2 (3 MSG_ERR2

Finally, | saved the ladder changes and project and then compiled and downloaded it to the control and
animated.



Note the E_MODSVR is enabled, SCON_OK and error outputs are all zero.

Bq network #5
Example ASFB for the Modbus/TCP Server.
- SERVER
| E_moDsVR |
ENABLE SCON_OK
i/1 = ENOD CNOK
SCON_FL
2 »— SLOT  CNFL |- { —
NO +0
BOOLS[0] — BOOL  CERR —3 SC_ERR _
RCMD1
255 — BSIZ revt — }—1
+1 +0
DATA[0]  >—{ DATA ERR1 [—3 CON1_ERR
MSG_FL1
255 »— DSIZ TER1 - { —
NO +0
EXPT[0] >—{EXPT  COD1 —3 MSG_ERR1
RCMD2
R —R RCV2 - { —
+{
ERR2 —3% CON2_ERR
MSG_FL2
TER2 - { —
+0




Next using Modbus Poll as the Modbus TCP master and to check if values can be written.

The target IP address (of the G&L ) must be specified ( and the Ethernet card on your PC has to be on the
same network ( first 3 octets of the IP address ) and both have to have a unique final octet. X.X.X.y.

Connection Setup >
Connection ok,
kodbus TCRAP w
Caricel

Senal Settings

IISE Serial Part [COMZ] taode

RTU ASCI

19200 B aud

Responze Timeout

3 D ata bitz
1000 [mz]

Ewen Parity
Delay Between Pollz

1 Stop Bit Advanced... [mz]

Remate Modbus Server

IP Addresz or Mode Mame

192.168.0.80 v|
Server Port Connect Timeout Of[=

sl Olpus

11



Initially the starting address will be zero and not using Base 1.
Read,/Write Definition >

Slave D: oK

Function: | 16 %Tite Multiple Registers - Caricel

Address: IZI Protocol address. E.g. 40011 - 10
Cluantity:
Scan Rate: 1000 [ms] Apply

Dizable
] Read/wiite Disabled

[ ] Dizable on emor Read ke Once

g
R oz

@10 20 (O80 (100 O Fit to Quantiy

[ ] Hide &liaz Columns [ ]PLC Addresses [Base 1]
[]Address in Cel [ ] EnrandD aniel Mode

On connection there are no errors so for demonstration purposes | set the first 10 registers ( 0 through
9 ) to test values 1,2,3,....etc.

Tx=447-Err=0:1D=1:F =16: SKE = 1000ms

d
[

Alias

I g
M G0 | ] O W s P —

wle|ule|v|s|wlm|a|s

12



pH Network #8

Now switching back to the animated ladder in PicPro and monitoring Network 8 the array of DATA[O]
through DATA[9] is the set values set by Modbus Poll. Keep in mind some Modbus TCP masters start
their address at 1, 40001, 400001, etc. where 1 will likely be equivalent to DATA[O] which is an offset in
addressing.

Boolean and Integer data area

+1
DATA[O]
+2
DATA[1]
+3
DATA[2]
+4
DATAL3]
+5h
DATA[4]
+5
DATA[S]
+F
DATA[G]
+5
DATA[T]
+9
DATA[S]
+10
DATA[9]
+
DATA[10]

to view data.

R S () (N A R (O (O

1

EN

IN1

IN2

IN3

IN4

ING

ING

INT

ING

IN9

IN10

IH11

MOVE

OK

ouTH

ouT2

ouT3

ouT4

ouTSs

ouTE

ouT?

ouTa

ouTS

ouT10

ouT11

The following yields the same result.

+0
— DATA[16]
. 0
— DATA[17]
. 0
— DATA[18]
. 0
— DATA[19]
. 0
— DATA[20]
. 0
— DATA[21]
. 0
—r DATA[22]
. 0
— DATA[23]
- ”
— DATA[24]
. 0
— DATA[25]

+0

— DATA[26]

13



Slave D oK
Function: | 16 %Tite Multiple Reagisters - Cancel
Addrezs: Frotocol addrezs. E.q. 40011 -> 10
Cluantity:

Scan Bate: [rnz] Apply

Dizable
] Readwiite Disabled
[ ] Disable on ermar FRead ke Once
Wi

Rowsg

@10 20 (80 100 CFit ko Quantity
[ ] Hide lias Column: PLC Addresses [Baze 1]
[]address in Cel [ ] EnrondDraniel Made

Note the Modbus TCP ASFB manual assumes a base 1 addressing scheme. Also note the array is shown

as BOOL(x) in the chart but in the sample project the array is named BOOLS(x). Likewise the integer

array is shown as DAT(x) in the chart but DATA(x) in the sample project.

Message Addressing

The addressing between the G&L and Modbus/TCP is as follows:

BOOLEANS

INTEGERS

Modbus PiC900

Modbus PiC900

00001 BOOL(0)
00002 BOOL(1)

00999  BOOL(998)

40001 DAT(0)
40002 DAT(1)

40999  DAT(998)

14



To test the Boolean data | setup Modbus Poll to use function 15-Write Multiple Coils.

Slave ID: oK

Function: | 15%/rite Multiple Cails w Canicel

Address; D Protocol addresz. E.g. 10077 - 10
CJuantity:
Scan Rate: 1000 [mz] Apply

Dizable
[ ] Read™iite Disabled

[] Dizable an erar ReadMvrite Once
Wiew
A s
@10 (20 80 (100 O Fikto Quantity
[ ] Hide &liaz Columns []PLLC Addresses [Baze 1]
[] Address in Cell [ Enron/D aniel Mode

15



For demonstrational purposes | set every other coil to 1.

e

= = | ==

Mbpoll1
¥x=222Err=0:1D=1:F =15 5R = 1000ms
Alias Q0000
1
0
1
0
1
0
1
0
0
[ Main Ladder - [E_MODSEX.Ido]
Network #8
Boolean and Integer data area to view data.
MOVE MOVE
+{EN OK |- - EN OK -
+1 +0 YES NO
DATA[O] — IN1 OUT1 — DATA[16] BOOLS[0] — N1 OUT1 |— BOOLS[16]
+2 +0 NO NO
DATA[1] — N2 0OUT2 — DATA[1T] BOOLS[1] — N2 OUT2 |—» BOOLS[17]
+3 +0 YES NO
DATA[2] 1 IN3 OUT3 — DATA[18] BOOLS[2] 1 IN3 OUT3 |—» BOOLS[18]
+4 +0 NO NO
DATA[3] 1 In4 OUT4 — DATA[19] BOOLS[3] 1 IN4 OUT4 |—; BOOLS[19]
+5 +0 YES NO
DATAL4] 1 IN& OUTs — DATA[20] BOOLS[4] 1 IN6 OuTs |—» BOOLS[20]
+6 +0 NO NO
DATA[S] 1 NG OUTE — DATA[21] BOOLS[5] —1 NG OUTé |— BOOLS[21]
+7 +) YES NO
DATALG] T QUTT — DATA[22] BOOLS[E] ] INT QUTT | —> BOOLS5[22]
+8 +0 NO NO
DATA[T] »— IN& 0OUTE |— DATA[23] BOOLS[T] — IN& OUT& —> BOOLS[23]
+9 +0 YES NO
DATA[8] 1 IN9 QUTY |—» DATA[24] BOOLS[E] —1IN9 ouTS —>» BOOLS[24]
+10 +0 NO NO
DATA[9] — IN10 OUT10 —> DATA[25] BOOLS[9] — 10 OUT10 —> BOOLS[25]
+0 +0 NO NO
DATA[10] 1IN OUTH |— DATA[286] BOOLS[10]  >— INM 0ouTH —;> BOOLS[26]
+0 +0 NO NO

16



Next | will demonstrate using KVB software to do the same thing as Modbus Poll.

| started by creating a new project and selecting Kollmorgen->Modbus Master RTU/TCPIP as shown

below.
f/ Choose Controller \‘l
Choose your preferred controller
ar OPC server in the menu below
("—9" Controllers \‘ w
Select brand Select protecol -
"/_% DEMO ) /’I‘_v'lm;lbus Master RTU/TCPIP D)
=
% G & L Motion Control
\ N J ] s
“) OPC UA Server
URL:

I Controller... IShawSe\eman_ -‘

Mame. D Active

S—&—9
T )

 Functions (4)
O Alarm Server

&) Multiple Languages

B secury

="
i oo

17



Under the Settings tab note the default is 0-based. If you want the addressing to look like the table in
the Modbus TCP ASFB manual you need 1-based but in this example | left it at 0-based because | like the
Modbus address count to be the same as the index of the DATA[x] array. | also added 20msec of silent
time.

Settings | Stations |
Modbus Master RTUSTCPIP 5.02.02

B Settings =
Communication mode Ethernet TCP/TP |
Default station ] f
Modbus protocol RTU
32-bit word mapping Motorola I
Addressing Decimal
Start address 0-bazed
Max block size (words) 16
Force function code 0x10 Disable

Crinmm cwimn Erzhla

Silent time {ms) 20

Clock reqister 40000
Communication method i
Advanced -

Silent time (ms)
Extra time (ms) that the communication line has to be silent between two telegrams. For
RTU the silent time is added to the normal silent time of 3.5 characters.

oK Cancel Apply Help

On the Stations tab | set the IP Address to the same as the target IP Address of the G&L controller
( Ethernet port ):

Settings  Stations l

Station | IF Address Fort Mode
0 192.168.0.30 502 1

18



For the initial test | created a tagl as INT16 and assigned the tag Controllerl Modbus address 40000
which should be DATA[O] in the ladder using 0 based addressing.

Screen] %7 Tags %

j Tags ” Controllers ” Triggers ” Poll Groups " Index Registers 1

Home |
Columns Visible Filter
[ Add <2 l Delete - Scaling Qthers | Cross Reference ‘ [ Show Selection... = Im
[] Data Exchange
—
Tag Controllers Scaling Others
Name Data Type Acress Right | Data Type Controller1 | Offset Gain Read Expr... Write Expr... Description Poll Group Always Active »

|
e e Resdvnte (BT en (el et

| added an Analog Numeric data field to the default screen and set it up to point to Tagl.

| built and ran the project. The value is displayed as 1 as expected.

KVB_To_MMC - - X

Next | changed the value on the touchscreen to 12345 and as you can see below DATA[0O] changed.

Main Ladder - [E_MODSEX.Ido] FVE_To Mc - - x

fiH Network #& ’ ’

Boolean and Integer data area to view data.

MOVE
JEn oK |
+12345 ) ) +0 ' 12345

DATA[D] >INt OUTY [ DATA[16]

+2 +0
DATAM]  >—]IN2 OUTZ |— DATA[17]

+3 +0
DATA[Z]  3—|IN3 OUT3 [—5 DATA[18]

+4 ) ) +0

19



To test the BOOL | added another tag in KVB and set it up as type BOOL and set the tag controller

address to 00000.

J Tags || Controllers || Triggers || Poll Groups || Index Registers ]

| added a button on the screen and pointed it to Tag 2.

Prclperties ROUMOrgen vIisUuanZanon Sulaer™™ L4U0 - RVE_10 MM

Home |
Columns Visible Fil
[ Add - [ Delete © Scaling Cthers
[] Data Exchange
Tag Controllers Scaling Others
Mame Data Type Access Right | Data Type Controller 1 Offset Gain Read Expr... Write Expr... Descriptic
Tagl INT16 Readwrite INT16 40000

0 1
N N N A N

lect Action... =

Set Analog &
Tag2

Set Analog =
Tag2 v
0

20



| built and ran the project again in KVB and during runtime when pressing and releasing the button on
the touchscreen | could see tha value of BOOLS[0] change from NO when not pressing to YES when

pressing the button.

12345
MOVE
Jen oK | ”
Wo -—uo >, | HO ’ ’ 1
BOOLS[0]  —]IN1 ouT1 M
HO HO | Button
BOOLSM]  —|IN2 0UT2 | BOOLS[7] {
YES ’ ’ o ’ ’
BOOLS[2]  — N3 OUT3 | BOOLS[18]
HO HO




